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Real Writer and Reader for Windows - User
Guide

Ghotit Real Writer & Reader is a comprehensive literacy solution combining several
advanced assistive technologies tailor-made for people with dyslexia, dysgraphia
and other learning disabilities. Ghotit helps children and adults with

dyslexia/dysgraphia to read, write and correct text in any application.

Ghotit’s patented Text Correction technology provides the most accurate fixes for
spelling, grammar and punctuation mistakes according to the intended meaning of a

text like nobody does.

Ghotit Quick Spell Word-Prediction is a state-of-art technology designed for writers
with typing issues and phonetic/creative writers; this technology increases writing
speed and successfully predicts intended words with instant correction of the first

misspelled letters.

Ghotit Reading technology makes any text document readable: hear text read aloud
in conjunction with dual highlighting. Ghotit Screenshot Reader reads even texts of

images, locked PDF files and other inaccessible documents in place.

Ghotit Real Writer & Reader 11 includes:

¢ Quick-Spell Word-Prediction with instant correction for creative/phonetic writers
¢ Predict Anywhere for Quick-Spell Word-Prediction working in any application
e Phonetic and context-sensitive spell checker

e Grammar and punctuation corrector

e Corrector of confused/misused words including homophones
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e Grammar and punctuation corrector including splitting of “fused” sentences and

comma splices

e Style & Clarity — Rewording overused words and synonyms

e Style & Clarity — Rewriting Passive Voice sentences to Active Voice
e Style & Clarity — Academic rewriting

e Style & Clarity — Removing Tautology and improving Conciseness
e Style & Clarity — Stopping Banned & Swear words

e Parts of Speech Analysis and Coloring

e Word-Prediction Topics (Advanced Word-Banks)

e Effective proofreader

e Speak as you write (speech feedback) letters, words and phrases
e Integrated dictionary

e Reading assistance with text dual highlighting

e Reading Anywhere for reading-aloud any text in any application

e Screenshot Reader able to read text in images, locked PDFs, etc.

¢ OCR Text recognizes text from screen and collects it to Ghotit Editor
¢ Highlighting texts and highlights collection

e Integration with Windows applications

¢ Independent Text Editor

e Ghotit Analytics — Progress Counters and Errors

e Examination Preferences - Forbid/Allow any feature of Ghotit in line with exams or

curricula requirements

e Modern accessibility technology (Newt)
e Low-Vision adaptations and keyboard shortcuts (New!)

e Dark Theme automatic adaptations (New!)

e Software Activation on Offline Computers. It was developed for military and
government installations (New!)

e External Monitors are supported on Windows and Mac (New!)
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e Absolute Privacy for users - the last but not the least:

https://www.ghotit.com/privacy-policy

Ghotit Real Writer & Reader integrates with common Windows applications (i.e.
Desktop Microsoft Office, Microsoft Office-365 Online, OneNote, Edge, Chrome,
Gmail, Google Docs/Google Drive, Facebook) for text correction and reading aloud.

Additionally, the software has its own dedicated “Dyslexia Text Editor”.

© 2007-2024 Ghotit Ltd. -6-
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Setup and Application Start
Prerequisites

Windows: Windows-10 and higher

RAM Memory: 8 GB is recommended

Local disk/flash space available: 1.5 GB.

Connect to the Internet for the license activation.

Note: If there is another assistive software working on this computer, i.e. 3-rd party dictation

software not from Windows, more memory could be required.

Download/Copy the Ghotit Installation File

You may access the Ghotit installation file by either downloading the file from the

Ghotit website, or by copying the file from a Ghotit CD.

Install the Ghotit Software

Double click on the Ghotit installation file with the green "smiley" icon: .
Installation requires administrative privileges, and normally, the default location

should not be changed.

If you are an administrator of a school, university or an organization, you can install
Ghotit software to any local folder on the PC of your choice shared by all Windows

users, but NOT to a network folder.

Note: Windows uers with SmartScreen protection enabled MAY get a message "Windows
Protects Your PC". Click the link "More Info" below and further "Run anyway" to run the

Ghotit installation. You may get a few more warnings, but the Ghotit installation will run.
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When installation completes, the link to Ghotit-Real-Writer-and-Reader software

appears as a blue "smiley" icon: . This is the link to use further for running the
software.
Since the green-icon installation file is not in need anymore, move it to a backup

location.

Run and Activate the Ghotit Software

Installation launches Ghotit Real Writer and Reader software automatically. Wait for
a few seconds until the Ghotit window appears (at an old PC, it could take up to a

minute).
1. Setup and Activate the Software Immediately.

The Ghotit Setup Wizard will guide you through all the configuration options and
activation of the Ghotit software:

a. Selecting the Software Configuration (the appropriate User Interface)

b. Adjusting the Voice preferences

c. Selecting your English dictionary

d. Activating Ghotit: enter your Ghotit License: username and password (u/p),

case-sensitive.

Note: If you are copying-pasting your u/p, select text only and paste with the Keep
Text Only option.

2. Setup and Activate the Software Later by "Run as Administrator"
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If for some reason (i.e. you have not received a valid license: username and
password) you decided to close the software and activate it later, follow the steps

below.

Right-click on the Ghotit software file: Ghotit-Real-Writer-and-Reader
On a tablet, make Press-and-Hold gesture. From the right-click menu, select

"Run as administrator" and provide administrative credentials if required.

See it depicted below:

N

%)

Open uEned|
Open file location af-ciniel-r

!;’ Run as administrator slelei-5)

N

Troubleshoot compatibility
Pin to Start
Scan with Windows Defender...

Pin to taskbar

Restore previous versions

Send to >

Cut
Copy

Create shortcut

Delete

Further, Ghotit Setup Wizard will guide you as specified above.
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To customize the software later, select Edit drop-down menu and click item

Preferences as shown below:

[/] Ghotit Real Writer & Reader 11 64-Bit - Perpetual Software

File Je[i§ Format Saved Texts Highlighed Texts License Help

POS . SYL
[1 00

Preferences...

Alternatively, get to the Preferences by clicking the Preferences button with “wheel”
image located on the Floating Toolbar:

Ghotit Floating Toolbar

abg Style o—o || r°°1
X | |~ |[2] | [ | o2 | Aloc

SR

© 2007-2024 Ghotit Ltd. -10-



Ghotit Real Writer & Reader 11 for Windows

Software Configuration

Real-Writer X

Select the Software Configuration:

® Comprehensive Assistance - Due for those with Dyslexia or Dysgraphia.

Analyze My Writing - Reviews your text and assists with clear written communication.

Next >>>

Figure #1: The Setup Software Configuration Screen: Select Configuration

Comprehensive Assistance with full assistive technologies enabled is the good
choice for those with Dyslexia, Dysgraphia and other severe reading and/or writing

issues.

Analyze My Writing - analyzes your text and helps you in writing clearly and

engaging by fixing grammar and re-writing the style.

You can later change the user-interface configuration mode by going to the

Preferences, right-most tab "Configuration".
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English Dictionary Configuration

Real-Writer ? x

English Dictionary: LK English w
Australian English

Canadian English
Mew Zealand English I

Descriptions Window Settings: South African English
LIS English

[] standalone window

Select English Dictionary and press Mext:

Mext ===

Figure #2: The Setup Wizard Screen: Select English Dictionary

At the screen English Dictionary Configuration, select the English dictionary of your
choice. You can change your selection of English Dictionary at any time by going to
Edit -> Preferences -> Tab “English”.

Ghotit Real Writer & Reader supports the following English dictionaries: Australian,
Canadian, New Zealand, South African, United Kingdom (UK) and United States
(Us).
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Text-to-Speech Voice Selection

Real-Writer

Test Voice

System Voice: Microsoft David Desktop - English (United States)

Microsoft David Desktop - English {United States
 Microsoft Hazel Desktop - English (Great Britain]
CereVoice Heather - English (Scotland)
Speaking Rate: Microsoft Zira Desktop - English (United States)
Vocalizer Expressive Lee Harpo 22kHz

Speech Feedback (Read words aloud as you write)

Dual Highlighted (Two Colours) Text to Speech
Word Highlighting Calour:

Phrase Highlighting Colour:

] Descriptions Window - Don't Speak Aloud (Mute)
[ word Prediction - Don't Speak Aloud (Mute)
[1 speling - Don't Speak Aloud {(Mute)

Configure Voice and press Next:

I Mext ===

Figure #3: Setup Screen: Select and Test Text-to-Speech Voice

At this screen, set the Text-to-Speech preferences.

Enter User Credentials (The License)

¥

i Real-Writer ?

Activate the Software:

X

Username ||

Password |

Cancel

Start 30-day Trial

Figure #4: Setup Screen: Activate the Software.

© 2007-2024 Ghotit Ltd.
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Note: The credentials, username and password, are case sensitive.

Alternatively, to start 30-day trial, click the button “Start 30-day Trial”, fill the form
and click on “Activate Trial”.

After activating the software, move the Floating Toolbar from the center of the

Ghotit Main Window to any place of your convenience.

Start Ghotit normally before you start any other software, particularly
before browsers and other assistive software, i.e. dictation software. Certain
pieces of assistive software are known to be taking all computer resources available

and not leaving Ghotit the minimum required to work.
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Writing and Correcting Text

Real Writer & Reader makes it easy for you to write a text and correct all spelling

and grammar mistakes.

The Editor (the Main Window)

Ghotit Floating Toolbar

A lEE N ER = )

(7] Ghotit Real Writer & Reader 11 - Perpetual Software
File Edit Format Saved Texts Highlighed Texts License Help

Standard ~ | Arial ~li8 v|E135 | A @ [H

Text Area

Figure #5: Ghotit Real Writer & Reader Application Editor (the Main Window) and
the Floating Toolbar

Write your text in the Text Area. You may opt to write your text with Speech

Feedback enabled reading you each written word aloud (see the

© 2007-2024 Ghotit Ltd. -15-
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Speech Options).

To correct the text, either place the cursor in front of the text that needs correction

abc
or select the text by mouse. Further, click the "ABC"”-button . The software

marks misspelled words, suspected confused words and grammar errors by red,
blue and green underlining, respectively. When Dark Theme is set, other colors are
used instead for a better contrast with the dark background.

Instead of clicking the button, you can use the Alt+(Fn)-F6 shortcut within the

editor or F6 outside of it.

Ghotit Real Writer & Reader 11 - Perpetual Software
File Edit Format Saved Texts Highlighed Texts License Help

Standard ¥ | Arial >~ |18 v | =150 ~
B Misspelled

B Confused
B Grammar

| sore bterflis in the garden. | did not under stand

it was winter at home bet it was summer at the

garden. | notest it was time for school. So | ran
awte so that | wood not be late. wen | got to

school | tol my frends abwie the garden.

Figure #6: Marking Text for Correction

Click on a marked word. The software will offer word correction suggestions in the
Suggestion Menu.
Alternatively, users, particularly those with low vision, can use Alt+(Fn)-F7

shortcut opening the Suggestion Menu for the first underlined word.

© 2007-2024 Ghotit Ltd. -16 -
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&

To approve and apply the selected changes, click the Apply button
within Ghotit: Alt+(Fn)-F12 ). Clicking the Apply button will also remove all

(shorcut

remaining markings and underground coloring from the Text Area.

To read out loud the text written in the Text Area with dual highlighting, click the

<y [

Speaker to toggle speech playback on/off.

Suggestions Menu

The text correction Suggestions Menu displays a list of suggested spelling or
grammar candidates and their descriptions. To select the correct word, click on the
word. The correct word will be inserted into the Main Screen text replacing the
misspelled word.

Additionally, software can read out loud the suggestions and their descriptions, by

)| |

clicking the Voice buttons. The Voice buttons ( ) are used to toggle

playback of the suggestion and its description to an on/off mode.

Alternatively, users, particularly those with low vision, can navigate the Suggestions
menu by arrow keys Up and Down with the suggestions being read aloud
automatically. To hear the descriptions, use the arrow keys left or right. To select

the correction, ignore it or add it to the dictionary, press the Enter/Return key.

© 2007-2024 Ghotit Ltd. -17 -
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Ghotit Real Writer & Reader 11 - Perpetual Software = O
File Edit Format Saved Texts Highlighed Texts License Help

Standard - Arial e - =150 A o (AR
B Misspelled
B Confused

B Grammar

4)) | sore bterflis in the garden. | did not under stand it

Albc || notest it was time for school. So | ran awte so that |

was winter at home bet it was summer at the garden.

wood not be late. wen | got to school | tol my frends

0

b "Would" is used to show your past plan or decision.

Y |abw . . -

e ThL would Would" is used to show that in the past you expected
somethina ta hannen.

1) Covered in woods. Wooded. 2) Belonging to the woods.

<)

Woody Sylvan.
o) wooed 1) Make love to. 2) Attempt to get.
o) who'd 1) Who would. 2) Who had.

Common name of the plant "Isatis tinctoria" whose leaves are
%) woad used to make a blue dye.
The dye made from the plant "lIsatis tinctoria".

o) Ignore Suggestions for: wood The substance of trees and the like.

Figure #7: Word Suggestions Menu

Style and Clarity

After correcting spelling and grammar, run Style & Clarity to improve the style of
your documents. Use either the button "Style” or the shortcut Alt+(Fn)-F9.

The text is underlined with options to re-style the text to make it clear and concise.
On the Ribbon above the text, tune the options best for your goals. For more Style

options, go to the Preferences, tab Style and fine tune more options.

© 2007-2024 Ghotit Ltd. -18-
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[7] Ghotit Real Writer & Reader 11 64-Bit - Untitled

File Edit Format Saved Texts Highlighed Texts License Help

Standard ~ | Al v ~l=1s0 A o [A X

All Issues Ll | All Issues ~ | v i v B [ | v B

Overused/Repeated Words Passive to Active Voice Formal Style  Clarity/Tautology ~ Corporate Clarity ~ Long Sentences ~ Banned Words

We are upgrading the equipment for your information only. They wouldn't tell me how much it costs - not
that we are really interested. This upgrade
whas tested and approved by John.

Clarify who or what did the action.

achnitetetandippiovedthiZupolade Correct the passive voice phrase to active.

Ignore Suggestions

Figure #8: Style and Clarity Improvements
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Descriptions, Synonyms and Parts of Speech

Get the meaning of a word in a written text by selecting a word or placing a cursor

on it and clicking the Descriptions Window button

the top toolbar.

[

)

p—
p—

located at the right side of

The meanings or usage examples are opened in a dedicated Descriptions Window

located just under the target word. The Descriptions Window could be configured to

be a standalone and user-located via Preferences->English preferences.

The text in the Descriptions Window is by default read aloud when the mouse cursor

hovers over the window, but it could be muted via Preferences->Speech

preferences.

Ghotit Real Writer & Reader 11 - Perpetual Software
File Edit Format Saved Texts Highlighed Texts License Help

Standard ~ | Arial ~16 ~|=E150 ~ A é. D;?] sg:r;,l Fos srt

InCOHSIStE Ghotit Word Descriptions X 5u|tS
dyslexia

A learning problem that makes it
difficult to read and write.

Figure #9: Descriptions Window

But kids with dyslexia and dysgraphia may have a rather

[1 oo

© 2007-2024 Ghotit Ltd. -20-



Ghotit Real Writer & Reader 11 for Windows

To improve your writing, enrich your vocabulary by considering Synonyms for the
repeating words in your text. Position the cursor on a word and press the Synonyms
SYN

Button L~ lto get the list of synonyms you can select from.

“Parts of Speech Analysis” (POS), Syllables and Analytics are not enabled by default.
Enter the Preferences and on the Tab Editor enable Show Educational Toolbar. After

restarting the software, you get the features.

POS
Press the button “Parts of Speech Analysis” LL1]to get words colored to the colors of

the parts of speech. Configure any colors for the parts of speech on the main ribbon

or in Preferences, tab Teaching.

SYL
For syllabification of the text press the button Syllables [O:0 to separate the words

to syllables. Configure colors and other preferences on the main ribbon or in

Preferences, tab Teaching

Word-Prediction

Word-Prediction helps a user to write by "predicting" a word the user intended to
type. Predictions are based on spelling, context, grammar, syntax, and
frequently/recently used words as well as by loaded Word-Prediction Topics. The
Word-Prediction feature assists in the writing of kids and adults who struggle with

typing as it enables them to write correctly with fewer keystrokes.

Ghotit Word-Prediction provides highly accurate predictions, specifically when the
writer has dyslexia or dysgraphia by using Ghotit Quick-Spell Word-Prediction
Technology - non-stoppable instant corrective word-prediction which continues

even when the writing contains several misspellings.

You can try to write with prediction the following:

"Help us to andes"

© 2007-2024 Ghotit Ltd. -21-
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and despite two errors already made in the attempted writing of the real word
"understand", the prediction suggests correctly the word "understand". Never give

up trying to write and expect the right prediction to come.

Albe

Press the Prediction button located on the left toolbar (within Ghotit the
shortcut is: Alt+(Fn)-F10 ) to activate "local" word-prediction in Ghotit Writer

Window and start writing in Ghotit window.

To write with word-prediction in any other application, i.e. Microsoft Word, press

instead the Predict Anywhere button e located on the Floating Toolbar.

Ghotit Floating Toolbar

i =i EE BRI A el =]

@ ©
File Home Insert Draw Design Llayout References Mailings Review View Help ‘ =} ‘ ‘f Editing ¥ |
A Arial (Body CS) ~|18 v~ — ([}
[y | oo re = A L8 &

@ B I Uvaax XA Paragraph  Styles  Editing  pictate = Editor  Add-ins
S A~ £« A hav AN ’ V )

Clipboard [ Font 5] Styles Voice Editor Add-ins v

Paste

You can write with Ghotit Quick-Spell Word-Prediction in
any text editing eppl

Ghotit - Predict Anywhere X
F1 | application ﬂ 1) Attention to. 2) Letter to an
authority. 3) [Science].

F2 apply |
F3 | applications

F4 applied

F5 | applicants

F6 applying

F7 applies

F8 | applicable
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Figure #10A: Writing in MS-Word by using “Predict Anywhere” window.

Note. Predict Anywhere is due to writing with prediction in any application, but not in Ghotit

Editor where Ghotit-local word-prediction (the left toolbar button) to be used.

To select a predicted word, hover the mouse above the prediction window to read
aloud the proposed predictions and choose the appropriate prediction clicking it by

mouse. Alternatively, use the F-key shortcut appearing from the left.

Ghotit Real Writer & Reader 11 - Perpetual Software = O X

Standard ~ | Arial vi16 ¥ | =150 ~ A é. [IEJ S’FY:.;'I P[D]S ;YIE_]

Ghotit analyzes the text and tr

'ﬂ ,) abc
Predict in Ghotit \/
F1 tries » [ 1) Tests. 2) Makes an attempt. 3) Stvle

Al X Hears. \y/
F2 try 1

0 F3  training @

Y N> g
F4 | treatment
F5 tried
F6 tree

F7  transport

F8 trade

Figure #10B: Writing in Ghotit Writer by using Ghotit-Local Word-Prediction Menu.

For Ghotit-Local Word-Prediction menu, the prediction list appears under the text
you are writing; choose a predicted word by clicking it by mouse or by using the
appropriate F-key left to the prediction.

Words in the list are automatically read aloud when cursor hovers above them. If

there are descriptions for a word available, right to the word appears a right-
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directed double arrow . When clicking the double arrow, a separate window
appears with meanings for the predicted word, and the meanings are read aloud.

Ghotit-Local Word-Prediction menu could be also navigated up and down by using
the arrow Up and Down keys with automatic reading aloud of the predicted
words. Read aloud the descriptions by arrow Left or Right keys. Next, select the
desired predicted word by Enter/Return key.

Al x
To turn off word-prediction, click the word-prediction icon . Word-Prediction has

several options that could be tuned for user convenience and/or for compliance with

examinations requirements.

Note for multi-screen setups: Move Ghotit windows, the Floating Toolbar and the
Editor window, to the screen where you are writing and restart (stop and start

again) Word Prediction.

Note, that Predict Anywhere window follows your writing only in MS-Office

applications like Word, Outlook but not in browsers and some other software.
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Text Editor: The Menus

The main screen offers a set of features to optimize the text editing experience.

The File Menu Icons:

[7] Ghotit Real Writer & Reader 11 - Perpetual Software
Edit Format Saved Texts Highlighed Texts License Help
[# New File CeN [T 150 - A ﬁ (B S;L._f
Open File Ctrl+O
I save Ctrl+S
Save As...
& Print... Ctrl+P
@ Print Preview...
=% Export to DOC, ODT or PDF... Ctrl+D
Quit Ctrl+Q

Albc

E New file — creates a new file

Open File — opens an existing file

Save — saves the text you have written to a file

Export —exports the text to DOC, DOCX, Open-Office or PDF file formats

@ Print — prints the file
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The Menu Edit Icons:

[7] Ghotit Real Writer & Reader 11 - Perpetual Software

Eile Format Saved Texts Highlighed Texts License Help

Staf ) Undo Ctrl+z -2 - =0 - A [BYE

) Redo Crl+Y ——

J Cut Ctrl+X

) Copy Ctrl+C
Paste Ctrl+V

Preferences...

Redo — redoes the last change

Undo — undoes the latest change

Cut — cuts the text

@ Copy — copies the text

Paste — pastes the text
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The Menu Format Icons:

[7] Ghotit Real Writer & Reader 11 - Perpetual Software

File Edit Saved Texts Highlighed Texts License Help
1B Bold Ctrl+B
T Italic Ctrl+1
= Left Ctrl+L
= Center Ctrl+E
= Right Ctrl+R
= Justify Ctrl+)

Standard

2 v E150 v | A @

Align text to the left

Center text

Align text to the right

Justify — Align text both to the left and right margins

Font Icons:

0) | Bold — mark text as bold
0]

Italic — alter text to italic letters
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The Text Format Icons:

' Standard :
b H Style — select text style
‘Lucida Crande H Font type — select font type
72 = . .
Font size — select font size
=150 v
Line Spacing — define line spacing for the selected text
— Font Color — select font color

s

Text background color — select text background color
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Text Editor: The Shortcuts

The standard shortcuts, similar to Windows common Control shortcuts, are seen in

the menus File, Edit and Format.

The non-standard shortcuts with the Ghotit Editor are:

- Alt+(Fn)-F3 or Ctrl-Alt-Space - Reading text - start/stop.

- Alt+(Fn)-F6 - ABC text correction in the Editor

- Alt+(Fn)-F7 - Open the Suggestion Menu for the first underlined word
- Alt+(Fn)-F9 - Style & Clarity text correction in the Editor

- Alt+(Fn)-F10 - Word-Prediction Local - starts/stops

- Alt+(Fn)-F12 - Apply/Approve text

*- The key Fn is required in most cases on laptops, etc.

Shortcuts for Navigation:

Ctrl + Left Arrow - Move the cursor one word to the left.

Ctrl + Right Arrow - Move the cursor one word to the right.

Home - Move the cursor to the beginning of the screen.

End - Move the cursor to the end of the current line.

Page Up - Move the cursor by scrolling the document view down by one screen.
Page down - Move the cursor to the top of the next page.

Ctrl + Home - Move the cursor to the beginning of the document.

Ctrl + End - Move the cursor to the end of the document.
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Shortcuts for Text Selection:

Shift + Arrow Keys - Select text.

Ctrl + Shift + Left Arrow - Select the word to the left.

Ctrl + Shift + Right Arrow - Select the word to the right.

Shift + Home - Select from the current position to the beginning of the current line.
Shift + End - Select from the current position to the end of the current line.

Shift + Page-Up - Select from the current position to the top of the screen.

Shift + Page-Down - Select from the current position to the bottom of the screen.

Ctrl + Shift + Home - Select from the current position to the beginning of the document.
Ctrl + Shift + End - Select from the current position to the end of the document.

Ctrl + A - Select all document text.
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Reading Text: Integration with Common
Applications
Ghotit Real Writer & Reader can read text from any text application e.g. browsers,

text editors and e-mail clients.

Ghotit Real Writer 8 Reader 11 64-Bit - Untitled
Edit Saved Texts Highlighed Texts License Help

«rurmES

Ghotit can read text from any application| It is

useful for proofreading.

Figure #11: Ghotit Reader Screen

To start Ghotit Reader, select some text in your application and press F3-key.

Clicking the Edit icon , switches the software to Text Correction Mode.

Note: If F3-key alone does not work, use the combination of the two keys:

Fn-F3 (press Fn-key and F3 together).

Alternatively, click the Reading-button on the Floating Toolbar.

© 2007-2024 Ghotit Ltd. -31-



Ghotit Real Writer & Reader 11 for Windows

The following shortcuts are active within the Ghotit Reader:

Ctrl + Alt + Space - Reading text start/stop
Ctrl + Space - Pause / Resume reading from the current cursor position
Ctrl + Up-Arrow - Read the previous sentence from the cursor position

Ctrl + Down-Arrow - Read the next sentence from the cursor position

Ghotit Reader screen icons:

« Read the previous sentence

b Read text

Pause reading
id

B Stop reading

Read the next sentence
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Text Correction: Integration with Common
Applications

You can access Real Writer and Reader from various Windows applications (i.e. MS-Office,
Libre Office, Apache Office, Internet Explorer, Firefox, Chrome, Gmail, Google Docs/Drive etc.)
simply by marking the text and pressing left-most ABC button on the Floating Toolbar or the
shortcut (Fn)-F6-key.

To use it:

1. Run Ghotit Real-Writer-and-Reader by double-clicking. You can minimize the window if
you want.

2. Write your text in Word, Outlook or any other program.

3. Select the text you want to correct by mouse or using the keyboard shortcuts (the same way

you mark text for copy and paste).

abc

4. Click the left-most ABC button > on the Floating Toolbar - the text you selected will be

automatically copied to Ghotit for correction.
Alternatively, use F6 key. If F6-key alone does not work, use the combination of the two keys:

Fn-F6 (press Fn-key and F6 together).

5. Ghotit window is activated; the text is transferred to it, and user gets suggested correction
candidates.

6. Correct your text in Ghotit and/or write more text i.e. by using in-Ghotit editor Word-Prediction
(the big button on the left toolbar).

7. Once you are done correcting the text, return it back to the originating application by clicking

g

the Apply button or use the shortcut Alt+(Fn)-F12 when Ghotit Editor is the active window.

The corrected text will then be automatically sent back replacing the text sent for correction.

8. Repeat the steps from 3 to 7 to correct another text.

Watch the video on how to use:

https://www.youtube.com/watch?v=CAbpshHiC2c
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To improve the style of your text, proceed with the steps above and use instead the Style &

Style
v

Clarity button or the shortcut (Fn)-F9.

Note: Text in Real Writer window is replaced on F6/F3/F9 or Floating Toolbar clicks
by a new text. The previous text is saved by Ghotit and could be retrieved from the
menu Saved Texts. Make sure you are saving the retrieved text to some file

immediately.
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Low Vision: The Recommendations

For Text Correction, follow the below steps:
1. Run Ghotit Real-Writer-and-Reader.

2. Write your text in Word, Outlook or any other program.

3. Select the text you want to correct by using the keyboard text selection shortcuts, i.e. Ctrl-A to
select the whole document.

4. Use the F6 shortcut key to transfer the text to Ghotit and run the ABC correction. If the F6-
key alone does not work, use the combination of the two keys: Fn-F6 (press the Fn-key and F6
together).

5. In the active Ghotit window press Alt+(Fn)-F7 to open the Suggestions Menu for the first
underlined text word with Ghotit suggestions. Navigate the Suggestions Menu using the arrow
Up and Down keys and read aloud the descriptions by using the arrow Left/Right keys. Select
the desired suggestion, ignore them or add to dictionary by the Enter/Return key.

Prior to opening the Suggestions Menu on Alt+(Fn)-F7, Ghotit reads aloud the context phrase and the
underlined word. Navigation within the Suggestions Menu reads aloud the suggestions. To mute the
reading aloud, select the checkbox “Mute reading on Alt+F7” and/or “Mute Spelling Menu” in

Preferences, on the left-most tab Speech.

6. Repeat step 5 multiple times till you finish the reviewing.

7. Proofread the text in the Ghotit editor by invoking reading it aloud using the shortcuts of the
active Ghotit window: either Ctrl+Alt+Space or Alt+(Fn)-F3.

8. When all done, apply the changes by using the Alt+(Fn)-F12 shortcut for the Apply/Approve
button - the corrected text will then be automatically sent back to the text editor replacing the text

sent for correction.

Returning the text to Word/Outlook, triggers Paste-Special dialog in these applications. Select within the

dialog “Unformatted Text” or “Unformatted Unicode Text” to preserve original formatting.

9. Repeat the steps from 3 to 8 to correct another text.
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To improve the Style and Clarity,
follow the above instructions for Text Correction but instead of F6 or Fn-F6 key at step 4, use

the shortcut key reserved for Style and Clarity corrections, namely: F9 or Fn-F9.

To read aloud some text in another application,
select the text and press F3 or Fn-F3 shortcut. The text is transferred to Ghotit Reader, and

reading starts. Manage the reading functions by using the shortcuts of the active Ghotit window:
Ctrl + Alt + Space - Reading text start/stop
Ctrl + Space - Pause / Resume reading from the current cursor position

Ctrl + Up-Arrow - Read the previous sentence from the cursor position

Ctrl + Down-Arrow - Read the next sentence from the cursor position

To write with Word-Prediction in the active Ghotit Editor,

start in the editor by Alt + (Fn)-F10 shortcut. To navigate the suggested words, use
Up/Down Arrow keys reading the suggestions aloud. Left/Right Allow key are
reading aloud the descriptions of the suggested predictions. To select a suggestion, use
the Enter/Return key.

For proofreading of the text in the active Ghotit Editor,

use the shortcuts Alt + (Fn)-F3 or Ctrl + Alt + Space to start/stop reading.
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Keeping Original Text Formatting of
Word/Outlook:

a) Go to the menu File of your Word. Next, go down all the way to the bottom and click "Options"
to enter "Word Options" screen.

b) On "Word Options” screen, click "Advanced" on the left bar.

¢) On the right bar, go down to "Cut, copy and paste" section.

Locate the option named "Pasting from other programs" with a drop-box to the right where
you select "Keep Text Only".

Next, make sure that the checkbox below named "Show Paste Options button" is selected
(the green color oval). If the checkbox is not selected, please select it.

d) Click OK to save the changes.

'y ™\
" Word Options ) ? X
General . . ) .
[ Automatically switch keyboard to match language of surrounding text
Display
Proofing Cut, copy, and paste
Save Pasting within the same document: Keep Source Formatting (Default) ~ |
Language Pasting between documents:  Keep Source Formatting (Default) V|
Accessibility Pasting between documents when style definitions conflict: | Use DestinatierrStytes<(Rafault) v |
[ Pasting from other program) Keep Source Formatting (Default)
Py Insert/paste pictures as: Keep Source Formatting (Default)
Quick A Toolb Keep bullets and numbers when pasting text withiKeep T i E—
uick Access Toolbar
[ Add control characters in Cut and Copy
Add-ins [] Use the Insert key for paste
yorp
Trust Center 1,Show Paste Options button when content is @
Use smart cut and paste® ‘ Settings... ‘
Link Handling
[ Open supported hyperlinks to Office files in Office desktop apps
Pen
v
oK Cancel
k‘ J
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To keep the original font and formatting in Microsoft Outlook:
a) Go to menu File of your Outlook, go down and click there "Options".

b) On the "Outlook Options” screen, click "Mail" on the left bar.

c) Then, on the right bar click the “"Editor Options”

Outlock Opticns M

»

General . - ar
Q Change the settings for messages you create and receive.
Calendar Compose messages # 3
Contacts /ﬁﬂ Change the editing settings for messages, Editor Options... | 4
Tasks Compose messages in this format: | HTML El

Motes and Journal

’ Spelling and Autocorrect... ]

Ay |:| Always check spelling before

Search sending

|| _bobile
d) Next, in the "Editor Options™ dialog box, click "Advanced" on the left bar

Ignore original message text in reply or forward

e) Then go down to the “Cut, copy, and paste” section, select "Keep Text Only" from the
“Pasting from other programs” drop-down list.
Next, make sure that the checkbox below named "Show Paste Options button” is

selected. If the checkbox is not selected, please select it. Finally click the OK button.

Editor Options m

Default paragraph style: -
I Show AutoComplete suggestions

Proofing

Advanced
I Asian fonts also apply to Latin text

|:| Automatically switch keyboard to match language of surrounding text
IME Control Active
IME Truelnline

IME Settings...

I Cut, copy, and paste

Within the same e-mail: Keep Source Formatting [Default) El
| Pasting between e-mails: Keep Source Formatting (Default) EI

Fasting between e-mails when style definitions P
| conflict: Use Destination Styles [Default) El

I Pasting from other programs:
| Insert/paste pictures as: Tight EI
Keep bullets and numbers when pasting text with Keep Text Only option

|:| Use the Insert key for paste

Show Paste Options button when content is pasted

Use smart cut and paste '

ok || Ccancel

T
p—
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Floating Toolbar: Integration with Common
Applications

The Floating toolbar could be particularly useful when for some reasons usage of F-
keys is not possible or of less convenience. When the toolbar is not required, hide it
by selecting the checkbox "Hide Floating Toolbar" in Preferences -> tab Advanced
and restarting Ghotit Real Writer and Reader.

Ghotit Floating Toolbar

Figure #12A: Floating Toolbar

Figure #12B: Floating Toolbar with enabled POS, Syllables and Highlighting Buttons

Floating Toolbar window is due to facilitate integration with Windows applications

and has the following buttons:

abc
- The Spelling Button to work exactly as F6 shortcut for Text Correction.

When user adds in Preferences Style corrections to the standard text

abcg
N

Style

correction, the icon changes to

Style
- The Style Button T to improve Style and Clarity
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- The Reading Button is parallel to F3-shotcut and due for Reading
Aloud
(<]
- The Screenshot Reader Button L"="1is due for reading any text directly on

screen including text of images and locked PDF file. After reading, the

recognized text is available via Ghotit Editor

-
oC
(-

'

-  The OCR Text Button

is similar to Screenshot Reader and due to get the

recognized text from screen to Ghotit Editor but without reading it aloud

- The Predict Anywhere Button

Albc

is due to writing with Ghotit Quick-Spell

Word-Prediction in any editing application

- The Read Anywhere Button

=)

window

POS
[1

- The Parts of Speech Button

SYL

to read-aloud the text selected in any

to make text POS-Analysis and coloring

- The Syllables Button 00t syllabify the written text

4
- The Show/Hide Highlighting Buttons é/_ - switches between the default short
presentation and the long presentation including highlighting buttons

£

- The Preferences Button

- The Bring the Editor to Front

to get fast access to the configurable parameters

Ed

is a convenience button to activate and

bring to front Ghotit Real Writer’s window from the minimized state or when

obscured by other windows

-  The Minimize Button

to minimize the Floating Toolbar

The Maximize Button to maximize the Floating Toolbar
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The Highlighting buttons are:

- The Highlight in Yellow Button
yellow

- The Highlight in Green Button
bright green

Jé/ - highlights selected text backbround in

,— - highlights selected text backbround in

- highlights selected text backbround in

light blue (turquoise, aqua)

- The Highlight in Blue Button é/

- The Highlight in Pink Button

pink

- highlights selected text backbround in

- The Erase Highlighting @ - removes highlighting from the backbround of

the selected text

- The Collect Highlighted Texts

N

"

- collects highlighted texts and outputs

them to Ghotit Editor or to Microsoft Word document

- The Create New Collection of Highlighted Texts " - forgets previously

collected highlighted texts and starts a new collection

The size of Ghotit’s Floating Toolbar could be adjusted with only necessary buttons

to stay depending on each user needs. This is explained in the Preferences ->

Floating section.
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Screenshot Reader

Ghotit Real Writer and Reader can read aloud text from images or non-accessible

documents.

o—o
<]
o—o

Click the Screenshot-Reader icon located on the floating toolbar to enter the

Selection Mode.
The screen gets dark, and the cursor gets crosshair. Select by mouse a rectangle
area and adjust the bright selected Reading Area by using the light-blue

colored handles of the border selection.

Ghotit Real Writer & Reader 5 is an integrated writing and reading solution
combining several advanced assistive technologies tailor-made for people with

dyslexia, dysgraphia and other learning disabilities. Ghotit helps children and adults

with dyslexia and dysgraphia to read, write and correct text in any application.

Figure #13: Screenshot Reader: Selection Mode.

You can always exit from the Selection Mode by pressing Esc key or mouse double-
click.

To read the text aloud press Enter Key; the software enters the Reading Mode and

reads the text aloud.
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(49 (] 1] [»] [m] [©]

Ghotit Real Writer & Reader is a comprehensive literacy solution combining several

advanced assistive technologies tailor-made for people with dyslexia, dysgraphia
and other learning disabilities. Ghotit helps children and adults with

dyslexia/dysgraphia to read, write and correct text in any application.

Ghotit's patented Text Correction technology provides the most accurate fixes for
spelling, grammar and punctuation mistakes according to the intended meaning of a

text like nobody does.

Figure #14: Screenshot Reader: Reading Mode.

When done, press the Close button located at the right-top corner of the Selected
Area or click the Screenshot-Reader icon once more to read another text area.
Reading could be paused, then resumed. After pausing, the text on screen could

also be read forward or back sentence by sentence.

You can always access the text read in Ghotit Editor by bringing the editor
E

text in Ghotit Editor or export it to a document by pressing the button Export and
selecting DOC, PDF, HTML or TXT formats.

to focus: click the button located on the right side of the Floating. Copy the

Note for the multi-screen setups: Move all Ghotit windows, the Floating Toolbar

and the Editor window, to the screen where you are reading.
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OCR Text

i
OCH
(W

The “OCR Text"” feature is similar to the “Screenshot Reader”. “Screenshot

Reader” reads aloud a selected area on screen with a recognized text being a by-
product and accessible in Ghotit Editor.
The "OCR Text” is a convenience function for users not interested in reading aloud

text on screen but rather in the recognized text itself.

Read Anywhere
Besides Ghotit Reader to copy any text from any window and read it with dual
highlighting and Screenshot Reader to read anything directly from the screen, Read-

Anywhere is an additional reading option.

[;5?

Just select any text, click Read-Anywhere button at the Floating Toolbar and get

the text read aloud on spot.

Dictation

The Dictation Button is a useful shortcut to the platform dictation available on Mac.

To dictate to Ghotit Editor window. Click the Ghotit Text Editor area. Next, click the

0
Dictation Button [ | located on the left toolbar of the Editor (NOT on the Floating

Toolbar).

To dictate to a window of another software/app, click in the editing area of the

\

external software. Next, click on the Dictation Button of the Floating Toolbar.

Dictate to the external software window.
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Privacy Attention! Check with your version of Windows system whether the voice

is treated locally or sent to Microsoft’s servers for processing and whether you can

change the defaults.

Voice Memos.

The features are available on Window 10, 11 and above.

The Voice Memos Button

=0

is due to create new and access existing voice files. It

works by activating Microsoft’s Voice Recorder App. Rename the files by double

clicking names and providing your own names.

Privacy Attention! Check with your version of Windows whether the voice is

treated locally or sent to Microsoft’s servers for processing and whether you can

change the defaults.
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Highlighting Texts and Highlights Collection
The feature is currently limited to a Desktop MS-Word and Microsoft Word Online -
an online version of Office-365 Word working in browsers (Internet Explorer, Edge,

Chrome and Firefox).

Open Word documents on your Desktop or in browsers, select some text and

highlight it by clicking either color button: é/ , g , é/ ,0r ,— . To clear text

from highlighting, use the Erase Highlighting button: @

Collect the highlights to Ghotit Editor or to a Microsoft Word document (choose in

Y
4

Preferences-> tab Highlights) by clicking button Collect Highlights:

To reset kept in Ghotit’'s memory highlighted texts and to start your new collection,

use the button Create New Collection of Highlighted Texts

There is a temporary collection of the last 20 files with highlights accessible from the
menu Highlighted Texts. Selecting a file from this collection opens the file collected
to Ghotit in Ghotit Editor and the file collected to MS-Word by the Desktop Word

application.

© 2007-2024 Ghotit Ltd. -47 -



Ghotit Real Writer & Reader 11 for Windows

Ghotit Analytics

Privacy Statement: In line with Ghotit Absolute Privacy Policy, all statistics and
analytics information is kept only locally on the computer and is never shared or
transferred outside the computer unless user decides to export it and follows the
required steps to share it with a tutor, teacher, trainer, etc.
Start Ghotit Analytics by clicking the icon located on the top toolbar of the Ghotit
Main Editor. The button is not enabled by default. To enable it, go to the
Preferences, the tab Editor, and select the checkbox “Show Educational Toolbars”.
The Analytics presents on the User-Interface:

- Usage Statistics with Progress Counters

- Fixed Spelling and Grammar errors with optional phrases

- Selected Predicted Words when writing with Word-Prediction (optional pre-

phrases).

Ghotit Analytics - 64-Bit - O *
File Advanced Help

Ij’ *? E @ & Default ~ | o —TextCorrection by Month — ~ | :| “= —Word Prediction by Month — ~

li1 In Editor - Number of Proofread Words W

In Editor - Number of Proofread Words
438

366

Value
%]
£

142

|:| L
10 2020 10 2020 10 2020 10 2020 112020
Date
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Figure #15A: Analytics — Graphs of Progress Information.

£7] Ghotit Analytics - 64-Bit
File Advanced Help
BBE @E|‘Dehjtv|§|cf11-mzn §|";—WordpredcﬁonbyMonﬂ1—V

| tiI - Progress Tracking Graphs — w

Typed Word ~ Correction Type Phrase

1 corexctyions corrections Spelling This is my corexctyions off the text.
2 off of Misused This is rmy corrections off the text,
3 Thiz i Spelling Thiz is my corexctyions off the text,

Figure #15B: Analytics - Fixed Spelling and Grammar Errors

[7] Ghotit Analytics - 64-Bit
File Advanced Help
B B E @1 “ & Default | | - —Text Correction by Month — | - 11-2020
: '[i7 —Progress Tracking Graphs —
Typed ALetters Word Pre-Phrase

andes understand Help us to andes

asing assignment complexity of the asing

comlex complexity to understand the comlex

Hel Help Hel

P/AHEAD to Help us

P/AHEAD understand the complexity
t us to understand t

u Help u
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Figure #15C: Analytics — Selected Predicted Words when Writing with Word-
Prediction

To get the Spelling/Grammar and Word-Prediction Errors collected as a CSV Excel-
friendly format file, create an empty folder and export the files from the Menu
Advanced -> “Copy CSV File to Folder”. After exporting the files, enter the folder;
the subfolders there named as “Text-Correction” and “Word-Prediction” contain
monthly files with collected errors originating from text-correction and word-

prediction, respectively.
To share your Progress Counters and Errors with your teacher/trainer/ATP, one
option is to export CSV files to a folder as explained above, next zip the folder and

share the file/files via email or a cloud with your teacher/trainer.

Yet another option is to Export the Ghotit Analytics to the Desktop located file by

clicking the toolbar button “Export Analytics to File”?. Next, locate the new

Analytics file on the Desktop and pass it to your teacher/trainer in charge.

To import the Analytics File to Ghotit Analytics, teacher on her/his computer opens

Ghotit Analytics, clicks on the toolbar button “Import Analytics from File”,
provides the file location to the File Dialog and clicks “"Open”. Ghotit Analytics
requires teacher to specify the unique name of the student/pupil to accomplish the
import. Next, teacher switches Users combo-box to the name of the student

specified and gets access to the analytics information.

The list of Ghotit Analytics Users contains the “"Default” user - this is the analytics
information set for this computer — as well as the unique names provided when
importing Analytics Files. To navigate among them, switch among the students’

names or return to Default (local) user.
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Customization: User Interface

User-Interface containing only necessary functions/buttons concentrates attention

and improves productivity.

To customize the Ghotit User Interface, right-click on the empty area of the Top,

Left or Right toolbar and get the Right-Click Menu with the list of functionalities

(actions).

Ghotit Floating Toolbar

Read Text

abc | | Style
N

O—0
[ ]
o—o

Correct Screen Reader

Style |

r~=A
OCR
C..J

OCR Text

R ENIRY

Predict

Read | | Dictate |

E

Voice Memos

L

Preferences

Eq

To Editor

@

Help |

Minimize

[/] Ghotit Real Writer & Reader 11 - Perpetual Software

File Edit Format Saved Texts

Standard ¥ | Arial

Highlighed Texts License Help

|12 v |E150 ~

Reading Toolbar

Format Toolbar

Descriptions & Synonyms Toolbar
ABC Ribbon Toolbar

Style & Clarity Ribbon Toolbar
Preferences Ribbon Toolbar
Voice Button Toolbar
Word-Prediction Toolbar
Dictation Toolbar

To Editor-Mode Toolbar
Spelling 8 Grammar Toolbar
Style & Clarity Toolbar
Approve/Apply Toolbar

Figure #16: Right-Click Menu for User-Interface Customization
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Select or unselect checkboxes to add or remove certain groups of buttons.
You can always return to the default “"Factory-Made” User-Interface by
going to the Preferences (select Preferences from the menu Edit), clicking tab
Advanced, pressing there the button “Restore the Default Layout”, closing the

software and running it again.

Customization of Ghotit’s Floating Toolbar is covered by the Preferences -> Floating
tab.

Customization: Preferences

To customize the software, select the Edit drop-down menu. Click item Preferences

to get Preferences.

/) Ghotit Real Writer & Reader 11 - Perpetual Software

File §2s0§ Format Saved Texts Highlighed Texts License Help

Ctrl+7 * |12 * |[E=150 ~ A éﬂ ES{I“;‘
Ctrl+Y -

Ctrl+X
Ctrl+C
Ctrl+V

Preferences...
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Figure #17: Opening Preferences via Menu Edit

Alternatively, get Preferences by clicking the Preferences button with “wheel” image

located on the Floating Toolbar:

Ghotit Floating Toolbar

S| @ || e BN Y B[O

Correct Style Read Text | | Screen Reader | | OCR Text Predict Read Dictate Woice Memos | | Preferences | | To Editor Help Minimize

Figure #18: Opening Preferences via Floating Toolbar
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After selecting Preferences, a new window with several tabs appears.

The customization tabs are:

1) Speech - Select the voice to read-out-loud a written text (text to speech
voice), word-highlighting & sentence coloring

2) English - Select English dictionary, customize Descriptions Window options
and add words to your Personal and Banned Words Dictionaries

3) Spelling & Grammar - Select the colors for underlining

4) Style - Customize the Style and Clarity options

5) Teaching - Select colors for Parts of Speech Analyzes and for Syllables

6) Prediction - Customize Ghotit Word-Prediction and colors of the Word-
Prediction window;

7) Learning - Create topics for Word-Prediction by learning from text files
and/or Ghotit Text Area;

8) Topics - Import, export, delete, load to use and unload from use Word-
Prediction topics to improve the quality of word-prediction;

9) Exams - Forbid/Allow any feature of Ghotit in line with your exam or curricula
requirements;

10) Floating - Adjust the size and customize the appearance (add/remove
buttons) of the Floating Toolbar

11) Editor (the Main Window )- Customize the appearance and colors of the
Ghotit Editor as well the shortcut F-keys used for Text Correction and Reading
Text Aloud;

12) Configuration - Configure the User-Interface with Full Assistive
Technology, Floating Toolbar only, Editor Only or "Analyze My Writing" Mode
due for those without Dyslexia/Dysgraphia. Switch between the default Light

Theme and the experimental Dark Theme. Select the proper Ghotit Analytics

Ghotit Real Writer & Reader 11 for Windows

option. The configurational changes require Ghotit restart.
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Speech Options

Real Writer & Reader offers read-out-loud services; it reads aloud:

- Written text;

- Suggested corrections and their meanings;

- Predicted words and their meanings;

- Meanings of any word selected by user in Description Window;

- Words as you write if Speech Feedback configured

Speech  English  Speling&Grammar ~ Frediction  Learning

Topics  Exams  Floating  Main Window

Advanced

Real-Writer ni

(] Read Aloud Letters
Read Aloud Words
Read Aloud Sentences

Dual Highlighted (Two Colors) Text to Speech
Word Highlighting Colar:

Phrase Highlighting Calor:

(] Mute Descriptions Window
[ Mute Word Prediction Window
[ Mute speling Menu

System Voice: Microsoft David Desktop - English (United States) w
I 1 1 1 1 1 1 I
Test Voice Speaking Rate: ! : ! ! : I : : !
Slow Fast
Speech Feedback (Read Aloud as You Write): Don't Speak Aloud (Mute):

Figure #19: Preferences: Speech Customization Options

Customize the Speech Options as shown on the figure above:
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- Select your preferred voice from the list of the available with your computer
text-to-speech voices.

- Select the Speech Feedback options to read-out-loud each letter, each word
and/or each letter while you are writing

- Select the colors marking the word and sentence by dual highlighting when
reading the text aloud.

- Mute reading aloud for descriptions, word-prediction or/or spelling windows.

- Mute reading on Alt+F7.
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English Language, Description Window and
Personal Dictionary

Real-Writer n

Speech English Speling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

English Dictionary: US English v
Australian English
Canadian English

New Zealand English
South African English

| UK English

Descriptions Window Settings:

[ standalone window

Custom Dictionaries: Personal Dictionary ~

Import from TXT File

Add Enter your word Speak Delete

Export to the Desktop

Figure #20: Preferences: Options for English Language, Description Window,
Personal and Banned Dictionaries - Select English Dictionary

Chose the English dictionary you want to use from the options:
e Australian English
e Canadian English
¢ New Zealand English
e South African English
e United Kingdom (UK) English
e United States (US) English

Ghotit Real Writer & Reader 11 for Windows
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Additionally, the screen provides configuration options for Descriptions Window

containing meanings of user-selected words and opening on clicking the button

[E

)

Descriptions on the top toolbar.
Descriptions Window could be configured to be a standalone and user-located by

selecting the checkbox “Standalone window”.

Yet another useful options on the screen are Personal and Banned Dictionaries. Add
words to either dictionary one-by-one by entering them to the text area and clicking
on the “"Add” button. Words could be added to your Personal Dictionary also from
the

Suggestions Menu when clicking "Add Word” button. To delete a word, select it and
click on “Delete”. “"Speak” button lets you hear a selected word aloud. Import/Export

dictionaries from your custom TXT file with a single-word per-line structure.
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Real-Writer n

Speech English Spelling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

English Dictionary: US English ~

Descriptions Window Settings:

[ standalone window

Custom Dictionaries: Personal Dictionary ~
| Banned Words Dictionary |

Import from TXT File

Add Enter your ward Speak Delete

Export to the Desktop

Figure #21: Preferences: Options for English Language, Description Window,
Personal and Banned Dictionaries — Select Personal or Banned Words Dictionary
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Spelling & Grammar

Real-Writer

Speech English Spelling&Grammar Style  Teaching Prediction Learning Topics Exams Floating Editor Configuration

Colours of the Spelling Window: Colours of Spelling & Grammar Underlines:
The Background Colour: . Misspelled Errors: .
The Text Font Colour: . Confused / Misused: .
Grammar & Punctuation: .
Spelling Window - Restore the Default Colours Spelling & Grammar Underlines - Restore the Default Colours
Spelling - Forbid Swear Words v Spelling - Bold Marking of Errors

Add Style to Spelling&Grammar (ABC) corrections

Figure #22: Preferences: Spelling and Grammar

e Spelling Window colors - Select background and text font colors or Restore
the Default Colors

e Colors of the underlines — Users can customize the colors used for marking
Misspelled Errors, suspected Confused/Misused Errors and Grammar &
Punctuation or Restore the Default Colors

e Bold Marking of Errors helps to improve visualization of the suspected
errors — select/unselect the checkbox

e Spelling - Forbid Swear Words

e Add Style to Spelling & Grammar (ABC) corrections
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Style and Clarity
After correcting spelling and grammar, run the Style & Clarity to improve the style

of your documents.

Real-Writer nl

Speech English Spelling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

Overused, Repeated Words: Formal Style: v B
All Issues - [ ] Clarity and Tautology: v [ ]
Overused Words - Detection Sensitivity: | Mediumr ~ Corporate Clarity: .

Too Long Sentences: v M above 30 ¥ |Words

Passive to Active Voice: Banned Words: .
All Issues = . Add your custom Banned Words on the tab "English”, Custom Dictionaries.
Add Style to Spelling&Grammar (ABC) corrections Restore the Style Defaults
i |

Figure #22: Preferences: Style & Clarity Options

e Overused, Repeating Words — Select the required style suggestions from "All
Issues", "Issues with Fixes" suggested or "Don't Correct". Customize the color
of underlining. Tune detection of overused same words and words with the
same root by selecting the Detection Sensitivity from High, Medium and Low.

e Passive to Active Voice - Select the required style suggestions from "All
Issues", "Issues with Fixes" suggested or "Don't Correct". Customize the color
of underlining.

e Formal Style - Enable/Disable and customize the color.

e Clarity/Tautology - Enable/Disable and customize the color.

e Corporate Clarity — Attention! It flags many words. Enable it only for your

corporate writing.
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Too Long Sentence - Enable/Disable, customize the color and select the
detection threshold (words number in sentence).

Banned Words - - Enable/Disable and customize the color of underlining. The
detected Banned Words include the custom Banned words added on the tab
English (select instead the Banned Words Dictionary instead of the default
Personal Dictionary) along with the build-in dictionary of the swear English
words.

Restore the Style Defaults

Add Style to Spelling/ABC Corrections — Select the checkbox to add Style
corrections to the Spelling and Grammar corrections. We'd recommend this
choice only for the cases when only a few Spelling, Confused, Grammar and

Punctuation errors are expected in the text.
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Teaching

Real-Writer n

Speech English Spelling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

Parts of Speech - Highlighting Colors: Syllables - Syllabification Settings:
Nouns: B Syllables Separator: .
Pronouns: || Odd Syllables Color : B
Verbs: B Even Syllables Color : [}
Adijectives: B Bold First Letter:
Adverbs: .

Prepositions: .

Canjunctions: .

Interjections: .

Parts of Speech - Restore the Default Colors

Figure #23: Preferences: Teaching — Parts of Speech Marking and Syllabification
Options

e Parts of Speech — Customize the highlighting colors for each of the eight parts
of speech

e Syllables - Customize the highlighting colors for syllables
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Prediction Options

Real-Writer

Speech  English  Speling®Grammar ~ Predicion  Learning  Topics  Exams  Floating  MainWindow  Advanced

(] standalone - Don't Follow the Cursar Predict Phrase

Number of Words: 8 v Phonetic/Creative Spelling
Prediction Window - Background Color: . Insert Space after Word
Prediction Window - Font Color: . Predict Ahead

Restore the Prediction Defaults

Figure #24: Preferences: Personalize Word-Prediction

e Use standalone window - configure the word-prediction windows to be a
standalone window to be placed by user at any position on the screen. After
configuring this option, restart the software;

e Number of words — maximum number of predicted words to be presented;

e Prediction Window Colors - Select the colors to be used for background and
text;

e Restore Prediction Defaults - restore the factory defaults for prediction;

e Phonetic /creative spelling — Allow word-prediction to use Quick-Spell instant
corrective algorithms and suggest predictions even when there are no

completions for the written letters;
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e Insert Space after word - adds space after each inserted predicted word.
e Predict Ahead - predict the next word before typing the next word first letter.
e Predict Phrase - predict the next two words where it's possible.

e Forbid Swear Words.

Topics ("Prediction Word-Banks") & Learning

Writing a text on a very specific subject requires a specific lexicon and/or general
words used in specific subject-dependent combinations or in their rather rare

meanings.

To improve a quality of word-prediction, use Ghotit Topics. Known alternatives to

Ghotit Topics are commonly called "Word-Banks”.

Ghotit Topics are superior to Word-Banks since the Topics contain not only words,
but also adopt a writing style suitable to the topic. Even if a Topic does not add a
single new word to the Ghotit dictionary, the Topic will improve Word-Prediction and

suggest predictions more accurately based upon the context of your writing.

Writing with word-prediction school assignments or professional writing could be

significantly improved by using Ghotit Topics.

© 2007-2024 Ghotit Ltd. -65-



Ghotit Real Writer & Reader 11 for Windows

Creating Topics: Learning from File or Ghotit

Real-Writer n

Speech English Speling&Grammar Prediction Learning Topics Exams Floating Main Window Theme

Learn from Ghotit; G|

Learn from File:

Select Topic: Add MNew Topic:
Dinosaurs R Enter Topic Mame | (+]

Topic's New Words:

iguanocdon
ankylosaurus
parasaurclophus

Figure #25: Create Topics and Review Words

For example, let us create a new topic named Dinosaurs. The Dinosaur topic will
include names of dinosaurs and a matching writing style suitable for writing

academic articles about Dinosaurs.

Steps to create a topic:

© 2007-2024 Ghotit Ltd. -66 -



Ghotit Real Writer & Reader 11 for Windows

1. If it is a new topic, type the topic name, Dinosaurs, to the “Add New Topic”

text-field in Learning tab of Preferences and click buttonD. For an existing

topic, select it from the topics list under “Select Topic”.

2. Learn new words and contextual connections to the topic by either:

a. Clicking “Learn from Ghotit” button to learn from Ghotit Text Area

I

(format txt) from a file dialog.

b. Clicking “Learn from File” button and selecting a text-only file

3. Following step 2, you will optionally be presented a list of new words; you can
inspect the words, read them aloud using the button Speak. Delete the words
you decide are not appropriate whatever is the reason. If there are no new
words listed, it’s still fine since the topic has been enriched by contextual

connections.

Note: When there are multiple documents, you wish to be learned to a topic, save
them in text format (txt) and learn the text files one after another by following step
2b for each file. Thus, your topic will contain all necessary contextual information

along with discovered new words - all taken from those multiple files.
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Topics (V'Prediction Word-Banks"™)

Real-Writer
Speech English Spelling&Grammar Prediction Learning Topics Exams Floating Main Windaow Theme
Import Topic:
Export Topic: to Desktop
All Topics: Topics In-Use:
Dinosaurs Dinosaurs
Load
»
Unload
€«
Delete Speak

Figure #26: Manage Topics: Load, Unload, Import, Export or Delete.

This screen is for managing topics. Here you can:

1. Import a topic file (file with Ghotit .ghtopic extension) i.e. which was sent to
you by a teacher. Alternatively, you can create your topic and fill it by
learning from files or Ghotit text area as described in previous section.

2. Export a topic to your Desktop. Select a topic in “All Topics” section and click

the “Export Topic” button. Now you can find the topic file on your Desktop
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and i.e. share it with your pupils by emailing it or placing it on a memory

stick, etc.

. Load a topic to use it. If you have created or imported a topic, it doesn't

mean that the topic is in use. Load it to use explicitly by selecting a topic from
“All Topics” section and clicking the Load button for Word Prediction to use

these words.

. Unload a topic from use. Select a topic in “Topics in-Use” section and click

Unload button. The topic to be kept but not used for word-prediction.

. Delete a topic. If you do not need a topic anymore, you can select it from “All

Topics” section and click the Delete button. Prior to deleting, you should
unload the topic from use and it is advisable to Export the topic and keep it in

some folder for a fallback.

. Read a topic name aloud. Select a topic either in “All Topics” or in “Topics in-

Use” section and click Speak button.

© 2007-2024 Ghotit Ltd. -69 -



Ghotit Real Writer & Reader 11 for Windows

Exams - Control the Allowed Features
Real-Writer n

Speech English Speling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

Check the boxes to allow features and uncheck to forbid. Administrative Rights are required.

Word-Prediction - Anywhere Spelling, Grammar & Punctuation
Word-Prediction in Ghotit Editor Style & Clarity

Read Aloud - Anywhere Saved Texts

Read Aloud in Ghotit Editor Screenshot Reader

Highlighting OCR Text

Syllables Descriptions & Synonyms
Dictate Parts of Speech

Allowr All Features

Figure #27: Exams. Allow or Forbid Certain Features of the Software.

Depending on your curriculum or examination requirements, define the subset of

the features allowed. Any changes require Windows Administrative Privileges.

To make changes, run the software as Administrator by right clicking the blue Ghotit
icon on Desktop and selecting "Run as Administrator" option. Next, provide your
Windows Admin credentials. Uncheck the boxes to forbid certain features or check
them to allow the features back. Button "Allow All Features" is provided for your
convenience to check all unchecked boxes. Close the software. Next, run it as usual
and get the subset of the features defined allowed. Inform your students about the

subset of the features available.
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Floating — Customize the Floating Toolbar

Real-Writer n
Speech English Speling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration
[ Hide Floating Toolbar

Toolbar Size & Style; Small Size v

Speling, Grammar & Punctuation Button Partz of Speech Button

Style & Clarity Button Syllables

Reading Button Highlighting Buttons

Screenshot Reader Button Preferences Button

OCR. Button Editor to Front Button

Predict Anywhere Button Help Button

Read Anywhere Button Restore the Toolbar Defaults Dictate Button

Figure #28: Floating — Customize the Floating Toolbar

In Floating Toolbar size combo-box choose among Small, Medium, Large or “With
Text-Labels” pre-defined sizes of the Toolbar. Selection of "With Text Labels” adds

the text labels below the icons thru all toolbar buttons.

Appearance of all buttons could be customized, whereas “Restore the Toolbar

Defaults” restores the factory defaults after Ghotit restart.

If for some reason the toolbar is not required, it could be hidden by selecting the
Hide Floating Toolbar checkbox.
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Editor (the Main Window)
Real-Writer nl

Speech English Spelling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

Default Text Font: Avrial - Editor - Background Colour:

Default Text Font Size: 12 - Editor - Font Colour: .

Text Correction Shortcut F-Key: F6 - Editor - Correction Area Colour:

Read Text Aloud Shortcut F-Key: F2 - Editor - Restore the Default Colours
Editor - Restore the Default Layout Editor - Show Preferences Ribbon: v

Show File, Edit, Format Toolbars:

Show Educational Toolbars:

Figure #29: Preferences: Editor (the Main Window)
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Configure on the tab:
- Font and font size that will be used by the software Text Area
- Main Area Text background and spelling selection colors
- Spelling Window background and font colors
- Show Preferences Ribbon
- Show File, Edit and Format Toolbar
- Show Educational Toolbars
- Restore the default colors of the Spelling Window
- Restore the default layout of the software

- F-keys to be used for Text Correction and Reading.

The default Text Correction mode short key is F6. However, if you want to change
the short key because F6 is being used by your application, you can do that by
going to Edit>Preferences >Advanced -> Text Correction Shortcut F-Key.

The default reading mode short key is F3. However, if you want to change the short
key because F3 is being used by your application, you can do that by going to
Edit>Preferences - Advanced -> Read Text Aloud Shortcut F-Key.
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Configuration — User-Interface, Theme and
Analytics Preferences

Real-Writer n

Speech English Speling&Grammar Style Teaching Prediction Learning Topics Exams Floating Editor Configuration

Ghotit Analytics Mode:
Select Theme:  Light Theme - The Defauk L Progress Counters & Errors - The Default ~

Ghotit Privacy Statement:
All Analytics Data is kept locally on this computer.

User Interface:  Assistive Editor & Toolbar - The Default w

Figure #30: Preferences: Editor (the Main Window)

Configure the User-Interface with Full Assistive Technology (The Default), Floating
Toolbar only, Editor Only or "Analyze My Writing" Mode due for those without
Dyslexia and/or Dysgraphia.

Schools are using the option "Floating Toolbar only" then they'd like to allow only
Word-Prediction and Reading technology and not to show the Text Correction

options.

You can switch between the default “Light Theme” and the experimental “"Dark
Theme”. Next, restart the software and after restart enter the Preferences again to

customize relevant colors where it is required.
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The default choice for Analytics is to collect information for Progress Counters and
Errors but without the phrases where the errors occurred. On shared computers,

consider changing it to "No Analytics” or “Progress Counters Only”.

When switching to the Analytics option “Progress Counters with Errors and Phrases”,
please be aware about phrases being included to the information exposed and
exported. Therefore, do it only where it is indeed needed i.e., for a deep analysis of

writing issues by a qualified and certified professional.
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Strategies for Teachers/Tutors

Tip 1: Text Correction by Two Iterations.

Encourage a student to write even if the resulting writing could be barely read.
Run the first correction by clicking ABC-button and correct the text by selecting

the correction candidates. Ignore the words without appropriate candidates.

Click the ABC button for the second correction. Thanks to the improved context,
many words without appropriate candidates at the first run now will have good
correction candidates. Additionally, the second run may bring correction of

punctuation.

Tip 2: Writing with Ghotit Word-Prediction Followed by Ghotit Text Correction.

There is our blog devoted to this strategy:

http://www.ghotit.com/2014/05/dyslexia-literacy-boosted-by-synergy-of-different-technologies/

Ghotit and Windows Start-Up

Installation adds Ghotit to the MS-Windows Start-Up. To disable launch of Ghotit

with each computer/Windows start, disable Ghotit entry within the Windows Start-
Up Menu. For example, on Windows-10 start Task Manager i.e. by right clicking the
Windows bottom bar and selecting from the menu item “Task Manager” or by Ctrl-

Alt-Del and clicking on option “Task Manager”.

On Task-Manager window, go to the tab Start-Up and right-click at the Ghotit entry
to Disable/Enable it.
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License Transfer

Transfer to another Computer

Unlike other vendors in our industry, Ghotit allows to transfer the installed software

and license from a functioning computer to a new or just another computer. You

can do it as a very rare event — no more than once a year.

To release the License, proceed with the steps below:
- Ensure good connection to the Internet;
- Make sure you have the activation license (username/password pair);
- Close the software if it's running;
- Run the software “As Administrator” by right-clicking the software blue icon
and from the right-click menu selecting "Run as administrator" - see the

picture at the next page;
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Open file location

& TortoiseSVN

B8 Addto archive...

B Add to "Ghotit-9-Real-Writer-and-Reader.rar”

B8 Compress and email...

; it=o - \Wriiter-and-Reader.rar” and email

Troubleshoot compatibility

Pin to Start

T-Zip

CRC SHA

Scan with Windows Defender...
Pin to taskbar

Restore previous versions

Send to

Create shortcut
Delete

Rename

Properties

- Select from the Ghotit menu License menu-item “Inactivate” and provide your
license (user/pass pair);
- Only after getting confirmation about successful inactivation, uninstall the

software.

To install and activate the software on another computer, copy the installation file

from your backup and proceed with the Installation and Setup steps.
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Hardware Changes

Certain hardware changes could make the license mismatching hardware. If that

happens, please buy a new license.

End User Rights

To build the application with your own version of Qt-library used by Ghotit Real
Writer & Reader under GNU LGPL-V2, you have rights to get the object files of the
application and building instructions. Please, contact our Support Team to get it. The

object files are delivered as stripped release compiled objects.

The Ghotit Analytics module is covered by GPL-V3 license. End users are eligible to
get the code source files of the module along with building means. Please, contact

our Support Team to get the sources.
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